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Caution! 
This software must be operated as described in this user guide and documents referred to herein. Please read the entire guide and referred 
documents before attempting to use this software. 
 

Contacting support 
Technical information including product literature and answers to questions regarding the operation of the NucleoView™ NC-250™ not covered in 
this document and referred documents is available through the following: 

• For e-mail support, send questions to NucleoCounter NC-250™ Technical Support on the address support@chemometec.com 

• Check out the FAQ section under support at www.chemometec.com  

• To speak with a Technical Support Specialist, call (+45) 48 13 10 20. 

Please note the NucleoCounter NC-250™ serial number and have it available when contacting ChemoMetec support. The NucleoCounter NC-
250™ serial number is found on the label affixed to the rear side of the instrument. The version number of the NucleoView™ NC-250™ software 
shall also be noted, this can be found on the Help – About menu item in the NucleoView™ NC-250™ software. 
 

Sales and ordering information 
For sales assistance with NucleoCounter NC-250™ or the NucleoView™ NC-250™ software, to place an order for a NucleoCounter NC-250™ or 
consumables, call (+45) 48 13 10 20, fax (+45) 48 13 10 21, or send e-mail to sales@chemometec.com 
 

Disclaimer notices 
The material in this document and referred documents is for information only and is subject to change without notice. While reasonable efforts 
have been made in preparation of these documents to assure their accuracy, ChemoMetec assumes no liability resulting from errors or omissions in 
these documents, or from the use of the information contained herein. 
 
ChemoMetec A/S reserves the right to make changes in the product design without reservation and without notification to its users. 
 

Copyright notices 
Copyright © ChemoMetec A/S 2020. All rights reserved. No part of this publication and referred documents may be reproduced, stored in a 
retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording or otherwise, without the prior 
written consent of ChemoMetec A/S, Gydevang 43, DK-3450 Allerod, Denmark. 
 
ChemoMetec and NucleoCounter are registered trademarks owned by ChemoMetec A/S. NC-Slide A2, NC-Slide A8 and NucleoView are trademarks 
of ChemoMetec A/S. 
 
All other trademarks are the property of their respective owners. 
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Quick guide 

1. Install the NucleoView™ NC-250™ software and the NucleoCounter® NC-250™ instrument as 
described in the documentation on the USB stick containing the NucleoView™ NC-250™ software 

 
2. Start the NucleoView™ NC-250™ software by double-clicking NucleoView™ NC-250™ icon on the 

desktop 
 
3. Wait while the NucleoCounter® NC-250™ instrument initializes. The slide tray can be heard aligning 

during this process. When the LED on the instrument turns green, the instrument is ready 
 

4. Click the  icon (below the ‘F3’ key) and select the desired protocol 
 

5. Click the  icon to see the application note for the selected protocol 
Check that you have all the materials needed for this protocol (slides, reagents, etc.) 

 
6. Mix your cells sample with the correct solution(s) and load an NC-Slide A2™ or NC-Slide A8™ 

 
 

7. Eject the slide tray and insert the slide 
 
8. Select the chambers on the slide to be analyzed by clicking in the checkboxes. 

  
9. Optional: Write a descriptive text in the Sample ID field and enter a username in the Operator field.  
 
10. Press the ‘Run’ icon. 

A few moments later, the results of the analysis will be displayed.  
 
11. Repeat steps 6 - 8 to perform the same protocol again on a new sample. Run protocol from step 4 

to start a new type of analysis.  
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Installation guide 

Installation overview 

Important: You must be logged on as a system administrator to install the NucleoView™ NC-250™ system 
components. 
 
During initial installation you will typically install both the NucleoView™ NC-250™ software and one or 
more sets of NucleoCounter® NC-250™ instrument-specific configuration data. This involves installation and 
activation of various USB drivers on one or more USB ports. 
 
To uninstall the software, follow the Uninstall NucleoView™ NC-250™ software procedure. 
 

Minimum computer requirements and preparations before installation 

The following PC requirements must be fulfilled to perform the installation: 
1. Operating System:  Windows 10 

NOTE: The Windows operating system must not be virtualized 
2. Logon using an account with administrator rights 
3. At least 4 GB RAM and 10 GB free disc space (recommended) 
4. At least 2.0 GHz frequency (clock speed) 
5. At least one USB 3.0 or USB 2.0 port1 
6. Minimum 1366 × 768 pixels screen size 

NOTE: A screen resolution much greater than this will result in windows which the user may find 
too small and difficult to read. If this happens, the screen settings must be configured to a lower 
resolution. 

 
To perform the installation, you will need the NucleoCounter® NC-250™ instrument and the NC-250™ 
Package which comprises power supply, cables and the USB stick containing the software. 
 
IMPORTANT: Make sure the serial number printed on the instrument matches the serial number on the 
USB stick. 
 

Installing NucleoView™ NC-250™ software on the NucleoCounter® NC-250™ instrument 

This section describes the software and instrument installation on Windows 7. For other versions of 
Windows there will be minor variations, but generally, simply accept all the default settings as they appear. 
Software and instrument installation typically take 5-8 minutes. 
 
 

 
1 If a USB 3.0 port is used, it must have proper USB 2.0 support (all modern USB 3.0 ports have this) 
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To initialize installation, do as follows: 
1. Review the previous section of this user guide about minimum computer specifications and 

preparations 
2. Ensure that the NucleoCounter® NC-250™ is NOT connected to the PC 
3. IMPORTANT: Log on with administrator rights for this installation session 
4. Insert the USB stick containing the software 
5. Windows will detect the USB stick and present an AutoPlay window if AutoPlay is enabled. 

Select the Open folder to view files-option 
 

 
 
NOTE: If AutoPlay is not enabled, open the contents of the USB stick using Windows Explorer 

 
6. The directory contents on the USB stick will be shown. Double-click on the Install NucleoView™ NC-

250™ X.X.X.X file (the number, e.g. 0.1.19.0, will vary depending on the version to be installed) to 
launch the installation program 
NOTE: It is the .exe file you should double-click, not the .bin file. The .exe file is associated to the 
installation icon and not the the .bin file icon 

 

 
 

7. If a window stating ‘Do you want to allow the following program from an unknown publisher to 
make changes to this computer?’ appears, click ‘Yes’ 

8. After a few seconds, the ‘Welcome to the NucleoView™ NC-250™ install wizard’ window will 
appear. Click ‘Next’ 
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9. In the Prerequisites window, confirm that you have disconnected all NucleoCounter® instruments 

from the PC. Click ‘Next’ 

 
 

10. In the ‘Ready to install NucleoView™ NC-250™’ window you will be given options to install or 
upgrade the NucleoView™ NC-250™ software itself, to install configuration data for specific 
instrument(s) and to browse for instrument configuration data which are stored elsewhere. Select 
the appropriate option(s) and click ‘Next’ 
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11. In the License agreement window, read the license agreement. To proceed, you will have to select ‘I 

accept the agreement’ and click ‘Next’ 
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12. On the ‘Select additional tasks’ window, select the desired options and click ‘Next’. 

Checking the ‘Associate ChemoMetec files with the NucleoView™ application’ will associate the 
image files *.cm and protocol files *.cmsx with the NucleoView™ NC-250™ application making it 
possible to open the files directly by double-clicking 

 
 
13. In the ‘Ready to install’ window click ‘Install’ 

 
The ‘Install’ window will appear and show progress of extracting and copying files. 
NOTE: During the installation, some windows may appear to pause. This is most likely due to 
installation of redistributable files within the Microsoft framework. Please wait for these files to 
install and do not close the window. This process may take several minutes. 
You may also see a command prompt window appear briefly, reporting installation of a driver. 
 

14. On the ‘Window security’ window click Install 

Installation of FTDI CDM divers may appear.  

a. Select ‘Extract’ on the FTDI CDM Drivers window 
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b. Select ‘Next’ on the Device driver installation wizard window 

  

c. Select ’I accept this agreement’ and click ’Next’ 

  

d. Click ’Finish’ to complete the FTDI driver installation 



 
 NucleoView™ NC-250™ user guide 

Document type: User Guide Document version: 1.13   
Document no.: 991-0252 Approved by: iap Approved date: 07nov2022 System ID: 11470 

 

ChemoMetec A/S · Gydevang 43 · DK-3450 Allerod · Denmark · support@chemometec.com · www.chemometec.com  Page 12 of 66 
 

  

15. On the ‘Window Security’ window click Install 

OPTIONAL: To prevent this window from appearing during future software upgrades, select the box 
Always trust software from ‘MATRIX VISION GmbH’ 

 

16. In the ‘Completing the NucleoView™ NC-250™ install wizard’ window, there is an option to deselect 
the checkbox if you only wish to install the software without attaching the instrument 
Click ‘Finished’. 

 
 

17. In the ‘Completing the NucleoView™ NC-250™ install wizard’ window, you can select the option to 
restart the PC later. However, the software requires a restart of the PC to operate correctly. Make 
sure to login with the same user credentials after restarting. Click ‘Finish’ 
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18. After installing NucleoView™ NC-250™ software, two new shortcuts are found on your desktop. 

One is the NucleoCounter® NC-250™ instrument icon used to launch the NucleoView™ NC-250™ 
software, the other is a shortcut to the data folder where NucleoView™ NC-250™ stores application 
data. 

 
 
After restarting the PC, NucleoView™ NC-250™ software is successfully installed. 
 
The NucleoView™ NC-250™ program will now automatically be launched and it will guide you through the 
instrument installation procedure, if the check mark for ‘Install NucleoCounter® NC-250™ instrument after 
install has finished’ was selected. 
 
NOTE: Depending on file versions and previous install history, a reboot of the computer may be requested 
before launching the NucleoView™ NC-250™ program. If a reboot is needed, it is essential that you log on 
using the same administrator user credentials used for the installation. 
 
Connecting the instrument 

1. NucleoView™ NC-250™ is now launched in the installation guided mode. Click ‘OK’ to continue 
installation of the NucleoCounter® NC-250™ Instrument 

 
 
2. Follow on-screen instructions to install the NucleoCounter® NC-250™ instrument using the USB 

cable and power supply. Note that the instrument icon in the upper left corner of the application 
bar is red when no instrument is attached 
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3. You will see a series of pop-up messages from the Windows operating system informing about 
driver installations. Among those are: 
- A USB hub inside the NucleoCounter® NC-250™ instrument 
- FTDI device driver  
- The camera 
 
When the NucleoView™ NC-250™ software has detected and initialized the instrument, the 
previously red icon changes to true life colors indicating the instrument has been successfully 
installed 

 
4. NucleoView™ NC-250™ will display a dialog box stating successful installation of the instrument and 

recommends that you continue installing this instrument on the remaining USB ports on the PC. 
Click ‘Yes’ to do so 

 
 
5. You will be prompted to unplug the USB cable from the USB port on the PC. Do this and click ‘OK’ 

 
 
6. When NucleoView™ NC-250™ detects that the instrument has been disconnected, the icon will 

again turn red, and you will be prompted to connect the instrument to another USB port on the PC 
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7. Repeat this procedure to install the instrument on the remaining USB ports of the PC 

 
8. If you are installing more than one instrument on the same PC, you must repeat the USB 

installation for all instruments on all USB ports, but note that only one instrument can be attached 
at any time 

 
9. Make sure that virus protection and other programs do not affect disc operations in the 

ChemoMetec data folder. Otherwise, sharing violations may occur when a program such as a virus 
protection program is scanning a cm file while NucleoView™ is trying to access the same file.  In 
virus protection programs, disable scanning of the ChemoMetec data folder and its subfolders: 
C:\Users\Public\Documents\ChemoMetec. Furthermore, if alternative folders are selected via 
‘Options’ in NucleoView™ NC-250™, remember to disable scanning of these folders 

 

Installing licenses and protocols 

Follow the procedure described in the ‘Licenses’-section to install licenses and protocols. This is not needed 
during a normal installation procedure, as licenses and protocols are automatically installed. 
 

Software upgrade 

New software releases are typically distributed via our website or on USB sticks and are installed as 
described below. Stored data (images), settings and installed licenses will be preserved. 

IMPORTANT: Login using an account with administrator rights for this upgrade session 
1. Disconnect any NucleoCounter® NC-250™ instrument connected to the PC 
2. Insert the USB stick holding the software upgrade or download and unpack the software upgrade 
3. Continue as described in the previous section ‘Installing the NucleoView™ NC-250™ software on 

the NucleoCounter® NC-250™ instrument’ and the NucleoView™ NC-250™ Install Wizard will now 
guide you through the remaining part of the upgrade.  
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Installing a new NucleoCounter® instrument 

To install one or more new NucleoCounter® NC-250™ instruments, use the USB stick holding the 
appropriate NucleoView™ NC-250™ software-release and follow the procedure in the section ‘Installing the 
NucleoView™ NC-250™ software on the NucleoCounter® NC-250™ instrument’. The NucleoView™ NC-250™ 
Install Wizard will guide you through the remaining part of the installation. While following this procedure, 
you will be given the option to specify which NucleoCounter® NC-250™ device(s) you want installed 
(identified by their serial numbers). Be sure to check the boxes which specify the new serial number(s) you 
want installed.  
You will also be given the option to browse for and select instrument data stored elsewhere. 
 
IMPORTANT: You may install multiple instruments on the same PC, but be aware that NucleoView™ NC-
250™ is only able to operate one instrument at the time. You must never try to operate more than one 
instrument as that may fail. 
 

Uninstall NucleoView™ NC-250™ software 

Either uninstall via Add/Remove Programs in the Control Panel of your PC or run the uninstall via the 
ChemoMetec ->NucleoView™ NC-250™ → Uninstall NucleoView™ NC-250™ in the Start Menu. This may be 
required if you wish to downgrade to an earlier version of NucleoView™ NC-250™. 
 

Validation with IQ, OQ and PQ protocols 

After installation or upgrade of the NucleoView™ NC-250™ software, NucleoCounter® NC-250™ instrument 
and/or  transportation of the NucleoCounter® NC-250™ instrument to a new location, we recommend that 
you perform validation by running the Installation Qualification (IQ test), Operation Qualification (OQ test) 
and Performance Qualification (PQ test) protocols as described below. 
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Installation Qualification (IQ test) 

1. Start NucleoView™ NC-250™ software by double-clicking the  icon on the desktop 
2. Wait while NucleoCounter® NC-250™ initializes. During this time, the motors may be heard 

positioning 
3. Click the    icon (just below the F3 button in the right side of the main window) to launch the 

Select Protocol window 
4. In the Select Protocol window, choose "Verification of NC-250" and "Test/calibration of NC-250". 

Select the "IQ Test" protocol in the list box in the lower half of the window (make sure that the NC-
Slide A2™ checkbox is selected) 

 

5. Click the    icon to view the application note for the protocol selected 
6. Follow the instructions on screen and in the application note to finalize the IQ test 
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Operation Qualification (OQ test)  

1. Start the NucleoView™ NC-250™ software by double-clicking the  icon on the desktop 
2. Wait while the NucleoCounter® NC-250™ instrument initializes. During this time, the motors may 

be heard positioning 
3. Click the    icon (just below the F3 button in the right side of the main window) to launch the 

Select Protocol window 
4. In the Select Protocol window choose "Verification of NC-250" and "Test/calibration of NC-250". 

Select the "OQ Test" protocol in the list box in the lower half of the window (make sure that the 
NC-Slide A2™ checkbox is selected) 

  

5. Click the   icon to see the application note for the protocol selected 
NOTE: Check that you have all accessories needed for this protocol available (slides, beads, etc.) 

6. Follow the instructions on screen and in the application note to finalize the OQ test 
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Performance Qualification (PQ test)  

1. Check that you have an NC-250 PQ Test (catalog no. 974-0004; Slides, beads). 

2. Start NucleoView™ NC-250™ software by double-clicking the  icon on the desktop 
3. Wait while the NC-250™ instrument is initializing. During this time, the motors may be heard 

positioning 
4. Click the    icon to launch the Select Protocol window 
5. In the Select Protocol window choose "Mammalian" and "Total Count and Viability" 

In the list box in the lower half of the window, select the "Viability and Cell Count Assay" protocol 
for the media type you wish to test 

  

6. Follow the instructions in documents for the NC-250 PQ Test Kit to finalize the PQ test  
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Main window 
 

 
 
 
Menu line: See the Menu line functions-section below for a more detailed description of content. 
 
Image tab page: When a file is selected, the image is shown on the left side of the main window. Zoom in 
and out on the image by using the scroll wheel with the mouse pointer inside the image area. Zoom by 
using the + or - keys Use smart zoom on a tablet PC (touch the screen with two fingers and slide them apart 
or together). Pan across an image using the ‘arrow’ keys or by dragging with the mouse across. 
 
Right-click options: Right-click on the image to get a context menu offering the following options: 

• Copy Bitmap Image: Copies the image area displayed to the clipboard 
• Track Position: Displays a bar in the top or bottom of the image, where the X and Y coordinates are 

displayed along with the pixel values for different channels in the picture. The format is X-position, 
Y-position: Pixel value Channel 0   Pixel value Channel 1   Pixel value Channel 2   … 
This feature can be disabled by right-clicking on the image and de-selecting Track position 

• Image Scaling: Opens the Image scaling-window, where the presentation of the image scale in the 
different channels can be modified. See the Image Scaling-section for further details 
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Main window controls: 
Yellow numbers in the figure above indicate the functions described in this paragraph 
 
1. Image selection controls. These controls are used to select which image to show when a file 
containing more than one image is selected. Images are numbered 1, 2, … 
 
2. Channel color. Colors assigned to each channel. Click on a channel color to enable or disable the 
display of the respective channel in the image 
 
3. Overlay control. When an analysis is successfully completed, the ‘overlay’ function is enabled. Left 
click to enable or disable the display of an Image overlay, highlighting the cells included in the analysis. 
See the Image Overlay section for more details 
 
4. Result tab page: When the result tab in the upper left corner is selected, a detailed overview of the 
active file result is displayed. Right-click the result tab to bring up a menu with options for copying or 
printing the results displayed. See the Analysis Results section for more details 
 
5. Volume input fields: The relevant volume controls for a selected protocol are located below the 
image. Right-click the individual fields for each parameter to switch from volumes to parts. Prior to 
starting an analysis, the volumes or parts used can be edited and the dilution or concentration of the 
sample will be used when calculating the results. Upon selecting a protocol, recommended volumes for 
the assay chosen are pre-selected, and can be modified as described. Reload recommended volumes by 

clicking the ‘Reload’ icons ( or ). If the sample volume or dilution is changed, and a solution input 
field is present, it will be updated with the volume or part recommended. If the user changes the 
volume or part in the solution input field, it will no longer be updated. 
Entering a negative number in the dilution input field indicates that the sample has been concentrated. 
The sum of the sample and dilution fields must be a positive number greater than 0.0001. The first 
multiplication factor input field is defined as the sample divided by the sum of the sample and dilution. 
Entering a number greater than 1 in this input field represents a dilution of the sample, whereas 
entering a number less than 1 represents a concentration of the sample. Note, that the volume input 
fields will automatically be updated with the recommended volumes or parts unless alternative input 
has been embedded via the Protocol Adaptation Wizard. The second multiplication factor (to the right 
of the first editable multiplication factor) is fixed and defined as the sample divided by the sum of all 
volumes or parts. 
 
6. Browse files: The upper right region of the main window shows the active data folder and files 
within. Left-click files in the selected folder to browse the results. See the Browse results section for 
more details. 
 
7. Select protocol: The instrument can perform different analyses depending on the protocol selected. 

To select a protocol, click the    icon. This will open the protocol selection window. When a protocol 

is selected, click the    icon to open the application note for that protocol. 
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The protocol can be attached to the ‘Favorite’ icons (named F1, F2 or F3, respectively) by right-clicking 
and choosing ‘Attach current protocol to button’. Load a favorite protocol by clicking the ‘Favorite’ icon 
or pressing F1, F2 or F3 on the keyboard. See the Selecting a protocol-section for more details. 
 
8. Media type: The specific slide type for a selected protocol is displayed in the box below the protocol 
box. If both NC-Slide A2™ and NC-Slide A8™ types are available for the selected protocol the slide type 

can be changed by left-clicking the    icon. 
 

9. Chamber selection: The chambers in which to perform the analysis can be selected by selecting the 
checkboxes next to the chamber. 
 
10. Sample ID: Prior to starting an analysis, enter a description of the sample can be entered in the 

sample ID input fields. These sample IDs can be deleted by pressing the  icon. The sample ID will be 
part of the file name. The file name consists of the date – a consecutive number – a number for the 
chamber number or a ‘c’ for cassette – and the entry in the sample ID input field. 
The sample ID can be changed after running an analysis by right clicking the file(s) and selecting 
Properties. The Sample ID can be changed in the according input field in the window that appears in the 
General tab page  
The sample ID cannot include the following characters: < > \ : * / ½ § ¨ ~ | ? ´ ¤ “ £ µ 
11. Operator: Enter the name or initials of the assay operator in the operator input field prior to 
starting the analysis. When browsing files, the operator field will display which operator was defined 
when the image file was created. 
The operator name cannot include the following character: # 
 

Current run and next run: The lower right part of the main window contain the main results of the active 
image analysis (from the last run or the file selected in the browse list). Detailed results are available by left 
clicking on the result tab page in the upper left corner of the main window. After running a protocol, the 
input fields will display entries for the previous analysis and be enabled for entering new data for the Next 
run. 
 

The   Run icon starts the analysis as per the protocol selected. During the first part of the analysis 
an ‘Analysis in progress’-image will show. 
 

The   Return icon returns the software to ‘Acquisition mode’ when the instrument is connected. 
 

  Pressing this icon inserts or ejects the slide tray. 
 

  Pressing this icon allows the user to export the results for the file on display as a CSV file. 
Note that the csv-file created in this way does not contain the same amount of information as an 
autogenerated csv-file. 
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Menu line functions 

File → Import package: Imports files into the NucleoView™ NC-250™ software. This will typically be a zip-
file containing license, protocol, and documentation files, or individual *.cmsx, *.cmsu and *.pdf files.  
 
File → Export data: Opens a window where the acquired data from an analysis can be exported in ACS or 
FCS file formats. See the Export data section for more details. 
 
File → Save image file as: Opens a window where the selected image can be saved as a TIFF or Bitmap file. 
 
File → Exit: Shuts down the program. 
 
Tools -> Plot Manager: Opens a new Plot Manager window, which can be used for advanced post 
processing of CM-files. See the Plot manager section for more details. 
 
Tools → Protocol adaptation wizard: Opens the Protocol adaptation wizard, used to create user-adapted 
versions of protocols. See the Protocol adaptation wizard-section for details. 
 
Tools → Report generator: Opens the File browser and the Report generator which are used to create 
results in a table format or for data export of one or several data files. See the Report generator-section for 
details. 
 
Tools → Create PDF report: Opens the PDF report dialog used to create and print PDF reports for individual 
files. See the PDF report-section for details. 
 
Tools → Options: Opens the options dialog. See the Options-section for details. 
 
View → Event logs: Opens a window where log files of all operations made by the user are recorded (see 
details in the Event log-part of the 21 CFR Part 11-section). 
 
View → License file: Opens the license file. See License, protocol and documentation installation for details. 
 
View → Application log: Opens the NucleoView™ NC-250™ log file window. This file can be useful for 
ChemoMetec support representatives if support is needed. 
 
Help → Software user guide: Opens the NucleoView™ NC-250™ software user guide (this guide). 
 
Help → Instrument user guide: Opens the NucleoView™ NC-250™ Instrument user guide. 
 
Help → About: Displays the About NucleoView™ NC-250™-window containing the software version number 
and information about the currently connected NucleoCounter® NC-250™. 
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Selecting a protocol 

 Press the ‘Select protocol’ icon (placed immediately below the F3 icon in the right hand side of the Main 
window) to open the Select protocol-window: 

 

 
 
Select values for ‘Organism’, ‘Analysis’, and ‘Media Types’ to see which protocols are available for this 
choice in the current installation. 
Select the protocol which supports the chosen media type (sample unit) and click ‘Select’. 
 
If the current installation holds any user-adapted protocols, these will be listed under their respective 
master protocols. 
 
By right-clicking on a protocol you can find details about that protocol or the protocol application note. For 
a user-adapted protocol, right-clicking will export the protocol adaptation for copying to another PC or to 
delete it. 
After export of the protocol from one PC, it can be imported into another PC by choosing File -> Import and 
locating the file of interest.  Import of a protocol with an identical name to an already existing protocol will 
result in two protocols with identical names. Therefore, we recommend renaming or deleting an old 
adapted protocol before importing new protocols. 
 
When ‘Hide protocols setup access’ under Tools → Authorization → User permissions is enabled for the 
current user, an extra icon ‘Hide Protocols …’ is shown just above the drop-down box. Pressing this icon will 
launch a ‘Hide protocols’ window, where it is possible to limit the number of protocols shown during daily 
use. Creating new cm-files with hidden protocols is NOT possible; they can, however, still run on already 
existing cm-files when run via Show Raw Data, Reanalyze Image File with Selected Protocol. Protocol 
Adaptation Wizard operations are NOT influenced by the protocol being hidden.  
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Analysis results 
 

 
 
When running a protocol, the main results ( ) will be displayed on the user interface and detailed 
results will be displayed in the result window ( ). Specific files can be opened from the Data folder 
and files-list in the upper right part of the main window. 
 
Image file (*.cm), Post processing file (*.cmpp) and Plot manager file (*.cmpm) 
 
Image files (*.cm)  

• Hold all primary analysis data (picture, instrument ID, settings, protocol used, etc.)  
• Have up to 3 color channels per image  
• Use a ChemoMetec proprietary file format with extension cm  
• Are named yyyymmdd-####-#-*.cm (year-month-day-number)-(chamber)-(sample ID).cm 
• Are placed in Today’s directory named yyyymmdd (year-month-day)  
• Today’s directory is created automatically in the Results directory  

 
The Results directory default location set during installation is typically: 
C:\Users\Public\Documents\ChemoMetec\NucleoView NC-250\results 
The location may be changed by the user via menu entry Tools → Options 

 
 
 

1 
2 
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Post processing files (*.cmpp) 

• Hold post processing results for a specific *.cm image file corresponding to one row in the Plot 
manager  

• Have the same file name as their corresponding image files (*.cm file), but with the extension 
‘cmpp’  

• Are placed in the same directory as their corresponding image file  
• Can also be saved in the Master files directory under the Results directory 
 
Using the Protocol adaptation wizard to add user specified post processing to adapted protocols results 
in “cmsu_*.cmpp” files, which are saved in the Master files directory under the Results Directory 
• Be careful during disk maintenance that you do not delete files in the Master files directory which 

are still needed for e.g. adapted protocols.  
 

Plot manager files (*.cmpm) 
• Hold a listing of loaded post processing files (*.cmpm)  
• A placed in the PM files directory under the Results directory  

 
Plot manager 
The Plot manager performs post-processing cell population analyses and can show results from multiple 
images in thumbnail-sized scatter plots and histograms. See the Plot manager-section for more details. 

 
  



 
 NucleoView™ NC-250™ user guide 

Document type: User Guide Document version: 1.13   
Document no.: 991-0252 Approved by: iap Approved date: 07nov2022 System ID: 11470 

 

ChemoMetec A/S · Gydevang 43 · DK-3450 Allerod · Denmark · support@chemometec.com · www.chemometec.com  Page 27 of 66 
 

Browse results 

 
 
Icons 

  In the upper right corner launches the File browser to browse images from a specified date range (day, 
week, month or year). 
 

 Marks the row for the selected file for which the image and extended results are displayed. 
 

 Click on this icon to select the file acquired in this chamber. 
 

 Return to ‘Acquisition mode’ to run a new analysis when the instrument is connected. 
 

  This icon inserts or ejects the slide tray. 
 

 This icon allows the user to export the results for the shown files as a CSV file. 
 
File list: 

• Click on a file in the data folder to browse results of ananalysis run. The file will be opened, and the 
image displayed. OPTIONAL: files acquired within the same slide may be selected by clicking the 
arrow of the desired chamber 
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• Pan and zoom settings are preserved from the previously selected file. Extended results for the 
selected file will be shown in the result tab. Furthermore, the protocol, media type, sample ID, 
operator and volumes will be shown for the file selected 

• Right-click options: Right-click on a file to get a context menu offering the following options: 

o Show data: Opens the selected file in Plot manager with the user-defined saved plots; if no 
plots have been saved, plots defined by the protocol will be displayed 

o Show raw data: Opens the selected file in Plot manager with the plots defined by the 
protocol 

o Reanalyze image file with Selected Protocol: Reanalyzes the image file with the protocol 
selected during acquisition mode and displays the results of this analysis. Be aware that the 
protocol selected is chosen in acquisition mode (when the Run icon is displayed). When a 
file is selected in the browse file list, the protocol name from the acquisition is displayed 
(when the Return icon is displayed), but the selected protocol will still be the protocol 
chosen in acquisition mode 

o Add to report: Adds the file to the Report generator from where the data can be copied into 
a spreadsheet program 

o Print: Prints the embedded data for the file 

o Print with Plots: Prints the embedded data for the file along with the original plots for the 
file 

o Create PDF report: Opens the PDF report dialog box, where a PDF report can be created 
and printed for the selected file 

o Approve: Option to approve the data for the file as relevant under 21 CFR Part 11 
guidelines. See the Approval part in the 21 CFR Part 11-section for further details 

o Start protocol adaptation wizard: Starts the Protocol adaptation wizard for the file 
acquisition protocol 

o Properties: Opens the Properties window for the file 
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File browser 

 
 
Select a date, week, month, or year on the left side of the File browser. This populates the right side with all 
images from that period. The first column lists file names and the following columns list further properties 
of each file. 
A red dot in front of the file name indicates that the file has been modified by a user after it was created or 
that the data was acquired with an unlocked user-adapted protocol. Modifications may be that a log entry 
has been added to the file, or that the file has been renamed. 
Double-click on a file in the list to open it in the Main window. 
 
Multiple files may be selected by holding down the Shift or Control keys and selecting files by left clicking. 
One option is to add the selected files to an open Plot manager by drag and dropping the selected files to 
the Plot Manager. 
 
Right-click options: Right-click on one or more selected files to get a context menu offering the following 
options: 

o Properties: Opens the Properties window for the file 

o Add to report: Adds the file to the Report generator 

o Print: Prints the embedded data for the file 

o Print with plots: Prints the embedded data for the file in addition to the plots saved for the 
file 

o Batch Export Data: Opens a window from which the analysis data analysis can be exported 
in ACS or FCS file formats. Be aware that multiple files can only be exported together if they 
have been acquired with the same protocol. See the Export data-section for details 

o Create PDF report: Opens the PDF report dialog, where PDF reports can be created or 
printed for one or multiple files 

o Approve: Option to approve the data for the file as relevant under 21 CFR Part 11 
guidelines. See the Approval part in the 21 CFR Part 11-section for details 

Right-click the header row in the right side of the browser and select ‘Columns set-up’ to specify which 
properties are to be listed.  
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File properties 

 
 
The file properties window contains three or four tabs: 

• General: Contains the file name and the sample ID. The sample ID can be edited after an analysis is 
complete. In the Log field the user can enter comments about the image file that will be logged in 
the file. NucleoView™ NC-250™ will automatically create entries in the log when a user changes 
Sample ID and when a user approves the cm-file 
 

• Details: Contains information about the image file 
 

• Description: A description of the actual image channel is displayed along with an optional comment 
about the image channel. The channel number can be changed by clicking the arrow icons 
 

• Post Processing: Describes details about the post-processing performed for the *.cm file. This tab 
page is only present when a corresponding *.cmpp post-processing file has been saved in the Plot 
manager 
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Report generator 
 

 
 
The Report Generator can be launched in several ways: from the File browser window by right-clicking one 
or more selected files and choosing ‘Add to report’; from the Browse file list in the main user interface by 
right-clicking a file and selecting ‘Add to report’; or via the menu entry Tools → Report Generator. The latter 
is used to generate a report for the files added to the Report generator. 
 
Multiple files may be added to the Report generator by selecting files while holding down Shift or Control 
keys and selecting ‘Add to report’ after right-clicking on the multiple file selection. 
 
Edit the file list using the four icons in the upper right side of the Report generator window. 
 
Click the 'To Clipboard’ icon to create a report on the clipboard, ready for pasting into a spreadsheet 
program. 
 
Click the ‘Show’ icon to show the Report created. 

 

Right-click options on the report shown: 

• Copy result to clipboard: Copies the displayed results to the clipboard 

• Save result to csv-file: Brings up a dialog box in which a csv file of the displayed results can be saved 

• Create transposed results: Opens a new window to which the results have been transposed 
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Image scaling 

 

When an image is presented on the screen, the color intensity (pixel intensity values) will by default be 
shown with automatic scaling and automated estimation of the background. For each channel, pixel values 
will be depicted in the color intensity range 0 - 255. 

The automatic scaling and the automated estimation of the background signal can simultaneously be 
turned off by clicking Auto Scale and the automated estimation of the background signal can be turned off 
by clicking Auto Bkg when Auto Scale is enabled. Note that disabling the automated background signal 
estimation may increase the depicted background in the shown image dramatically. When Auto Scale is 
disabled, min and max values can be entered to alter the depicted range. Remember to delete the * symbol 
to avoid automatic scaling. Contrary, if a * symbol is appended to a specified value, automatic scaling will 
be enabled. 

The Enhance function will depict low pixel values brighter. Disabling the Enhance function will display the 
image in linear scale. 

The Invert function will depict the image inverted, so the background appears white instead of black while 
the colors of each channel are preserved. 

To increase color contrast, you can estimate the background signal by right clicking on the image and 
selecting Track Position. When holding the arrow over a background area of the image, the pixel values of 
the background can be estimated for all channels. The values in track position are defined as following: X 
position, comma, Y position, semicolon, Intensity values for each channel separated by spaces, e.g. 700, 
500: 214 1476 15 which means that the pixel which the arrow is pointing at will have the X position 700, the 
Y position 500, the intensity in channel 0 will be 214, the intensity in channel 1 will be 1476, and the 
intensity in channel 2 will be 15. These values can be entered for the min value for each channel when Auto 
Scale is disabled. This will often give a better result in a bitmap export. 
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Image overlay 
 

 
 

An image overlay may be enabled with the    icon near the right bottom corner of the image. It performs 
two kinds of cell marking on the displayed image: 

• When an analysis is completed successfully, cells that are included in the analysis are marked with a 
square 

• When a large scatter plot or a large histogram is open in the Plot Manager the cells inside or 
outside the selected marker or gate, can be marked with the overlay squares by selecting ‘Add Cells 
Inside Selected Gate to Image Overlay’ or ‘Add Cells Outside Selected Gate to Image Overlay’ 
respectively 

The cells are marked with squares and this overlay can be toggled on and off by clicking the  icon.  
When one of the two overlay functions has been used, it is possible to choose cells in the Main window by 
holding the Ctrl key down and clicking on individual cells in the image. This will mark the most recently 
selected cell with a yellow square and previously selected cells with a pink square. Selected cells will be 
marked in Large scatter plots. 
The selected cells for the image overlay can be deselected by double clicking on the image, by right-clicking 

the   icon or the large plot and selecting ‘Delete Image Overlay’ or by right clicking on a large plot and 
selecting ‘Delete Image Overlay’. 
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See the Large scatter plot for details about polygons and cell gating. See the Large histogram plot for details 
about markers and cell gating. 
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Next analysis 
 

 
 
When a run is complete, the main result is displayed at the bottom right of the user interface and detailed 
results are displayed in the result tab. 
 
Input fields (optional): The user can enter Sample IDs for each chamber. The Sample ID is used as the last 
part of the image file name for all image files recorded by a given protocol. The user can change the 
operator, or the volumes used before the next sample run. 
 
When the input fields have been specified, press the ‘Run’ icon to start the next analysis. All settings will be 
transferred to the results data file. 
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Protocols 

To perform a particular analysis, it is important to use the appropriate protocol. This involves selecting and 
running that protocol on the NucleoView™ NC-250™ software while following the guidelines of the protocol 
as described in the Quick Guide section. 
 
Each instrument requires a unique license to run a protocol. Via the menu entry View → License File you 
can see a list of the Licenses installed. 
 
All protocols are user adaptable. The menu entry Tools → Protocol Adaptation Wizard opens the Protocol 
Adaptation Wizard window, which is used to create user-adapted versions of protocols. 
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Protocol Adaptation Wizard 
 

 
 
The Protocol Adaptation Wizard will guide you through adapting individual protocol parameters and saving 
the adapted protocol as a user-adapted protocol. A saved protocol may be locked by the user to prevent 
further changes. A locked protocol can be unlocked to overwrite it. A new adapted protocol, based on a 
locked protocol, can be saved by choosing the ‘save as’-function. All lock and unlock events are logged in 
the adapted protocol file. 
The Protocol Adaptation Wizard can also be used to apply master post processing to the analysis results. 
Hence, if a predefined set of markers, polygons and/or quadrants should be applied to new data 
acquisitions, it can be set up to do so automatically via the Protocol Adaptation Wizard for analytical assays. 
Please follow the guide in each step of the Protocol Adaptation Wizard. This guide is visible when then Help 
checkbox is marked. The Protocol Adaptation Wizard behaves in many ways like the Plot Manager: Read 
the Plot Manager section for a better understanding of the details. 
 
In case  a counting gate needs to be adapted, the gate can be modified in the Plot Manager and saved in 
the file. Afterwards, right-click on the saved file in the Main Window and select ‘Start Protocol Adaptation 
Wizard’. In Step 2, right-click the row dialog box (the gray area to the left of the row) and select ‘Reload 
Post Processing’. Select ‘No’ in the message box to overwrite the reloaded polygon (gate). Go through the 
remaining steps of the Protocol Adaptation Wizard and save the adapted protocol. 
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Plot Manager 
 

 
 
The Plot Manager is used for evaluation and post processing of cell populations in one or more image files. 
 
Results are displayed in scatter plots, histograms, and table plots arranged in rows and columns, where 
each row comprises results for one particular image file. 
The Plot Manager is specifically suited for batch processing of several image files as it can replicate 
processing from one ‘Master’ row to all rows selected. 
 

1. Master Row: Enter the number of the row that is to be used as the Master row, i.e.the template 
 

2. Apply: This ion replicates all processing from the Master row to all selected rows.  
NOTE: A blank area will appear in target rows if the channel defined in the master row does not 
exist in the file for the target row or if the parameter defined in the master row does not exist in 
the file for the target row 
 

3. Info field: The area to the right of the ‘Apply’ icon displays information regarding the plot 
coordinates and number of cells at the pointer position in the Plot Manager. 

 

  This icon launches a Statistics window which lists detailed gating statistics for all visible polygons and 
markers. 
 

  This icon launches a window to add Plot Manager files (*.cmpm) or post processing files (*.cmpp) to 
the Plot Manager. Each image file added will be appended as one new row. 
Two exceptions exist; adding a *.cmpp file from the Master files directory and when a *.cmpm file holds a 
master row. In these cases, the file will be added to row number zero (i.e. the uppermost row). In case row 
zero already contains an image data file, the new file will be appended as a new row. 
NOTE: It is possible to load image files (*.cm) and processed plot manger files (*.cmpp) into the Plot 
Manager by dragging them from either the Browse list in the main window or from the File Browser. 
 

  There are two ‘save’ icons in the Plot Manager. The ‘save’ icon exists for each row and is placed in the 
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Row window in the left part of the row. This icon saves the post processing data i.e. gates, polygons, 
quadrants, and graphs associated with the individual sample. The second type of ‘save’ icon at the top of 

the window is always present (next to the    icon) and saves the current Plot Manager contents to a 
*.cmpm file placed in a PM Files folder. This requires that all rows in the Plot Manager have been saved. All 
unsaved rows may be saved by right-clicking in the gray area in the top of the Plot Manager. The file name 
is user-defined in the edit field to the right of the ‘save’ icon.  
 
Three types of files can be added to Plot Manager with the following effects: 

1. Image files: These are image files (*.cm) on which no data processing, referred to as post-
processing, has been performed. If no previous post-processing has been saved, the new row will 
only show a row window on the left side of the Plot Manager window. If previous post-processing 
has been saved for this image, this post-processing will also be shown in the added row. See the 
description about the row window for details about what cell population data is loaded 

2. Post-processing files: A post-processing file (*.cmpp) contains post-processing results for a 
particular image file and has the same file name and is placed in the same location as the 
associated image file. Alternatively, the *.cmpp file location may be found in a special folder named 
Master Files which is accessible via the image browser. Such Master files are used when replication 
of post-processing to other data files is needed. Using the Protocol Adaptation Wizard to add user-
specified post-processing to a user-adapted protocol results in special “cmsu_*.cmpp” files being 
generated 

3. Plot Manager files: Plot manager files (*.cmpm) contain data for a complete plot manager session, 
i.e. for any number of images 

 
Right-click option: Right-click on the gray area in the top of the Plot Manager to see the options: 

• Show hidden rows: Toggles between showing and hiding rows marked as hidden 
• Save unsaved rows: Saves all unsaved rows 

 

Layout editing 

Please read the Row window section for details on how to use the Plot Manager. 
 

Scatter plots, histograms, or table plots can be added to the Plot Manager by left-clicking the  ,  or 

 icons, respectively. 
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Plot statistics 

 
The Statistics window lists detailed gating statistics for all visible polygons and markers. 
 
The figure above shows all available sub-columns. Right-click on a column header to edit which sub-
columns to display. 
If several different alias names have been set for a gate, the gate alias name presented in the statistics will 
be for the first row with an alias name. Example: if P1 has been named ‘live cells’ in row 1 and ‘GFP’ in row 
2, then the statistics window will show ‘P1 live cells’. 
 

 
 
Right-clicking in the table offers an option to copy table contents to clipboard which can be directly pasted 
into a spreadsheet program. 
 

Row window in Plot Manager 

 
The Plot Manager row window is used as a row header for the post-processing of a specific image file. It is 
always placed in the left side of the Plot Manager window. 
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Row number: The row number is shown in the upper left corner. 
 
Data source indicator: The data source of the cell population in this row is shown as a small colored square 
to the left of the ‘save’ icon: 

1. Grey: Indicates that the cell population has been loaded from data embedded in the image file, i.e. 
data which was obtained when the image was originally acquired and analyzed by running a 
protocol 

2. Green: Indicates that the data has been loaded from the main window, and the main window still 
holds the image file in memory. This is referred to as Main data (synchronized). This population is 
loaded instead of embedded data if the main window holds cell population data for that specific 
image file at the time when the row is added to the Plot Manager 

3. Orange: Similar to green, but the main window no longer holds the same image file in memory. 
This is referred to as Main data (not synchronized) 

 

  The ‘save’ icon saves the post-processing results in a *.cmpp file which is automatically given the same 
name and same location as the *.cm image file.  
NOTE: Any existing post-processing result for this CM-file will be overwritten. For all analytical assays, a 
*.cmpp file is saved automatically when running the analysis, hence it is not possible to do further post-
processing or saving of data in 21 CFR Part 11 mode since this will overwrite existing data. 
 
To generate saved *.cmpp files with data analysis in 21 CFR Part 11 mode, it is advised to use an adapted 
protocol containing a master template for the analysis of data. 
 
File name: The name of the image file is shown with vertical font in the left side of the row window. 
 
Checkbox: Select the checkbox under the ‘save’ icon if you want the row to be a target for the apply master 
function. 
 

  Click the ‘add scatter plot’ icon to add a new Scatter plot to the end of this row 

  Click the ‘add histogram’ icon to add a new Histogram plot to the end of this row 

  Click the ‘add table plot’ icon to add a new Table plot to the end of this row 
 
Right-click options: Right-click on the row window to see the options: 

• Show Image: Loads the row data’s corresponding image file (cm file) into the Main window 
• Save As Master: Saves this row’s post-processing as a Master for post-processing. The saved master 

can be loaded into subsequent Plot Manager sessions where the post-processing can be replicated 
to other rows 

• Reload Post Processing: Reloads the last saved post-processing of the file 
• Move Row Up: Swaps row position and number with the previous visible row 
• Move Row Down: Swaps row position and number with the next visible row 
• Remove Row: Removes this row from the Plot Manager, re-numbers subsequent rows, and moves 

the subsequent rows up 
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• Hidden Row: Toggles the hidden state of the selected row 
• Show Hidden Rows: Toggles between showing and hiding rows marked as hidden 
• Properties: Displays the File properties dialog box for the corresponding file  

 

Histogram plot in Plot Manager 

 
 
The histogram plot is used to plot a user selectable parameter together with a user-defined marker set 
which marks, gates and counts cell populations. 
The histogram above shows a histogram for the row data’s own cell population (red) plus an overlay with a 
histogram from another row (blue). 
 
Functions: 

1.  Data source indicator: A small colored square in the upper left corner indicates the source of the 
cell population (see  details in the Row window section of the Plot manager) 

2.  Select the ‘delete plot’ icon to remove a plot from the row. This will leave an empty area in 
which you may insert another plot or simply delete the area by right-clicking 

Double-click: To launch the Large histogram plot, double-click in the plot area. In the large histogram plot 
you can define axis parameters, markers, and gating settings. 
 
Right-click: Shows the context menu offering the following options: 

• Show Large plot (double-click)  
• Copy BMP to Clipboard  
• Copy Histogram  
• Paste Histogram  
Copy histogram and Paste histogram options can be used to insert and overlay histograms from other 
histogram plots. 
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Large histogram plot in Plot Manager 

 
 
The large histogram plot is used to set axis parameters, edit marker sets, define gate settings, and add 
overlay histograms: 

1. Axis settings: By clicking on the X-axis, it is possible to select type of axis, image channel, parameter 
type, and axis limits. By clicking the Y-axis, it is possible to select between count and percent, and 
by clicking ‘Max’ the axis max limit can be set: 

• Type of axis: Linear, Log or Bi-exponential. For Bi-exponential, it is possible to edit the 
below zero scale value 

• Image channel: Names of the available channels 
• Parameter types: The available parameters depend on the protocol used to generate the 

*.cm file 

2. Gating Setup: Launches the Gate configuration window, where gating settings can be configured 
for this plot 

3. New Marker: Creates a new marker 
4. Selected Gate: Edits the selected marker: 

• Move with arrow keys  
• Move Left end with arrow keys  
• Move Right end with arrow keys  
• Copy to Clipboard  
• Delete 

5. BMP to Clipboard: Copies the large plot to the clipboard to paste the bitmap image into a program 
of preference 
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6. Cancel: Closes the large plot without saving changes 
OK: Closes the large plot and saves the changes 

7. Line type and colors: These may be set with the controls in the upper right corner of the plot 
window after an additional histogram has been overlaid to an existing histogram 

8. Data source indicator: A small colored square in the upper left corner of the plot area indicates the 
source of the cell population (see further details in the Row window section of the Plot Manager) 

Right-click options: Right-click inside the plot area when no markers are selected to get a context menu 
offering the following options: 

• Paste Marker: Inserts a copied marker into the histogram plot 

• Show Gate Counts: Toggles between displaying count numbers and percentages for the gates 

• Copy Histogram: Copies the histogram curve 

• Paste Histogram: Inserts a copied histogram curve into the histogram plot 

• Delete Image Overlay: Deselects cells added to the Image overlay 

Depending on the state of the large scatter plot, some of the above options may be dimmed or be 
replaced with an alternative option. 

 
Right-click options: Right-click inside the plot area when a marker is selected to get a context menu offering 
the following options: 

• Paste Marker: Inserts a copied marker into the histogram plot 

• Copy Selected Gate: Copies the selected gate 

• Copy Histogram: Copies the histogram curve 

• Paste Histogram: Inserts a copied histogram curve into the histogram plot 

• Add Cells Inside Marker to Image Overlay: This option will add cells inside the selected marker 
to the image overlay, causing these cells to be marked with a non-filled, enclosing square 

• Add cells outside marker to image overlay: This option will add cells outside the selected 
marker to the image overlay, causing these cells to be marked with a non-filled, enclosing 
square 

• Delete Image Overlay: Deselects cells added to the Image overlay 

Depending on the state of the large histogram plot, some of the options above may be dimmed or 
not present. 

 
NOTE: Adding cells to the image overlay is cumulative when it is done from the same plot. When adding 
cells to the image overlay from another plot, the overlay is first cleared. Consequently, if you use this to 
select both inside and outside cells you may assume that all cells in the image should be marked with an 
enclosing square. This is, however, not always the case. If certain cells have been excluded from the cell 
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population, e.g. all non-single cells, then these are not part of the histogram, and therefore will not be 
included in the selected cells list. 
 
Editing a marker: A marker can be moved when the mouse curser is above the marker and is marked with 

the move icon . The left or right end of a marker can be moved when the mouse curser is above the end 

of a marker and is marked with the move icon . 
 

Scatter Plot in Plot Manager 

 
 
The scatter plot is used to plot two user-selectable parameters against each other, together with protocol- 
or user-defined polygons or quadrants which mark, gate, and count cell populations. 
 

1. Data source indicator: A small colored square in the upper left corner indicates the source of the 
cell population (see details in the Plot Manager section) 

 

2.  Click the ‘delete plot’ icon to remove a plot from the row. This will leave an empty area in which 
you can insert another plot or delete the area by right-clicking 

Double-click: To launch the Large scatter plot, double-click the plot area. On the large scatter plot, you can 
define axis parameters, polygons, quadrants, and gating settings. 
 
Right-click: Shows the context menu offering the following options: 

• Show large plot (double-click)  
• Copy BMP to Clipboard  
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Large scatter plot in Plot Manager 

 
 

The large scatter plot is used to set axis parameters, add or edit polygons and quadrants, and define gating 
settings as follows: 

1. Axis settings: By clicking on either the Y or X axis, it is possible to select type of axis scale, image 
channel, parameter type, and axis limits: 

• Type of axis: Linear, Log or Bi-exponential. For Bi-exponential, it is possible to edit the 
below zero scale value 

• Image channel: Names of the channels available 
• Parameter types: The parameters presented depend on the protocol used to generate the 

*.cm file 

The scatter plot below shows an example where the maximum X-axis limit has been set lower than 
the measured maximum. 

 
Note how cells outside the plot area are plotted in the margins, visualizing that the current X-axis 
max limit setting causes cells to fall outside the plot area 
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2. Gating Setup: Launches the Gate Configuration window, where plot gating settings can be 
configured 

3. New Polygon: Creates a new polygon. Click in the plot area to add points to the polygon. Click in the 
gray area around the plot to delete the last point of the polygon. Click on the starting point to close 
the polygon 

4. New Quadrant: Creates a new quadrant. Click the plot area to add the center point of the quadrant. 
Alternatively, click the quadrant and drag center and end points. Click away from the quadrant to 
deselect and finish quadrant editing 

5. Selected Gate: Edit the selected gate: 
• Set Alias Name 
• Show Info 
• Copy to Clipboard  
• Delete 

6. BMP to Clipboard: Copies the large plot to the clipboard to paste the bitmap image into program of 
preference 

7. Cancel: Closes the large plot without saving the changes to the row 
OK: Closes the large plot and saves the changes to the row 

8. Data source indicator: A small colored square in the upper left corner of the plot area indicates the 
source of the cell population (refer to Row window in the Plot Manager section) 

Right-click options: Right-click inside the plot area when no gates are selected to get a context menu 
offering the following options: 

• Paste Gate: Paste a polygon- or quadrant gate copied from another scatter plot 

• Show Counts: Toggles between displaying count numbers and percentages for the gates 

• Delete Image Overlay: Deselects cells added to the Image Overlay 

Depending on the selection status of the large scatter plot, some of the options above may be dimmed 
or replaced with an alternative option, e.g. Show gate counts can toggle with Show gate counts in %. 

 
Right-click options: Right-click inside the plot area when a gate is selected to get a context menu offering 
the following options: 

• Copy Selected Gate: Copies the selected gate 

• Add Cells Inside Gate to Image Overlay: Adds cells inside the selected gate to the image overlay 
(only cells that are shown in the plot), causing these cells to be marked with a non-filled enclosing 
square 

• Add Cells Outside Gate to Image Overlay: Adds cells outside the selected gate to the image overlay 
(only cells that are shown in the plot), causing these cells to be marked with a non-filled enclosing 
square 

• Delete Image Overlay: Deselects cells added to the Image Overlay 
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• Show Info About Selected Gate: Displays a new window with information on how many cells are 
outside and inside the gate in each image 

Depending on the selection status of the large scatter plot, some of the options above may be dimmed or 
be replaced with an alternative option. 
 
NOTE: Adding cells to the image overlay is cumulative. Consequently, if you use this to select cells both 
inside and outside the gate you may assume that all cells in the image should be marked with an enclosing 
square. However, this is not always the case. If certain cells have been excluded from the cell population, 
e.g. all non-single cells, these are not part of the scatter plot and therefore will not be included in the 
selected cells list. 
 
Editing a Polygon: First, select the polygon you want to edit by clicking close to one of the sides. Then select 
it again to get into ‘polygon editing mode’ indicated by red squares on the polygon corners. In this mode it 
is possible to remove points or add new points and to drag points to new positions. Details are described in 
the light gray area surrounding the plot. 
 
Editing a Quadrant: First, select the quadrant you want to edit by clicking close to one of the lines. Then 
select it again to get into ‘quadrant editing mode’ indicated by red squares on the quadrant lines. In this 
mode it is possible to drag points to new positions. Details are described in the light gray area surrounding 
the plot. 
 

Table plot in Plot Manager 

 
 
Table plots are used for to present data. For example, the percentage of cells inside a gate can be shown 
and acceptance criteria set up so that the output may show failed or OK in the red and green font, 
respectively. 

1.  Data source indicator: A small colored square in the upper left corner indicates the source of the 
cell population (see details in the section Row window in Plot Manager section) 
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2.  Click the ‘delete plot’ icon to remove a plot from the row. This will leave an empty area in which 
you may insert another plot or simply delete the area by right-clicking 

Double-click: To launch the Large table plot, double-click in the plot area. 
 
Right-click: Shows the context menu offering the following options: 

• Show large plot (double-click)  
• Copy BMP to Clipboard  

 

Large table plot in Plot Manager 

 
 
The large table plot is used to add or tables and edit the contents as follows: 

1. New table: Creates a new table. Click in the plot area to place the upper left corner of the table and 
select the number of rows and columns of the table 

2. BMP to Clipboard: Copies the large plot to the clipboard to paste the bitmap image into a program 
of preference 

3. Cancel: Closes the large plot without saving the changes to the row 
OK: Closes the large plot and saves the changes to the row 

4. Data source indicator: A small colored square in the upper left corner of the plot area indicates the 
source of the cell population (for details, see Row window in the Plot Manager section) 

Right-click options: Right-click inside a table cell to get a context menu offering the following options: 
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• Insert Formula …: Selecting Insert formula writes a = that indicates that a number or a calculation 
will be written in the selected table cell. Subsequently, “Insert value …” can be selected to insert a 
gate parameter or a protocol variable. Selecting gate parameter guides in steps to select the 
desired gate and parameter like % of plot or mean for the x-axis parameter. Protocol variables are 
values like volumes that are defined for each file when it was acquired with the protocol. 

Two or multiple gate parameters and protocol variables can be inserted in the same table cell along 
with calculation expressions like + - * /. See Calculation expressions below for more details 

• Format Cell …: Opens the Format cell dialog box that has two tabs: 

o Number:  

 The number of decimal places after the separator can be defined 

 Scientific notation can be selected 

 A 1000 separator can be enabled 

 A symbol can be defined in % 

o Font:  

 Set the font to be value-controlled 

 Set the threshold to low or high. If only one threshold is needed, set the same 
value for both the high and low 

 Select the color of the font for the different thresholds and write an alternative text 
in the table cell 

NOTE: Formatting a table cell only has a visible effect when the table cell is defined as a value (by 
writing = or selecting insert formula). 

Right-click Options: Right-click when the curser is placed on the lines of the table to get a context menu 
offering the following option: 

• Copy table content: Copies content of the selected table to the clipboard for inserting in a 
spreadsheet program 

Right-click options: Right-click when the curser is below or above a column and an arrow points to the 
column to get a context menu offering the following options: 

• Insert Column to the Left: Inserts a new column to the left of the selected column 

• Insert to the Right: Inserts a new column to the right of the selected column 

• Delete Column: Deletes the column selected 

Right-click options: Right-click when the curser is to the right or left of a row and an arrow points to the row 
to get a context menu offering the following options: 
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• Insert Row Above: Inserts a new row above the selected row 

• Insert Row Below: Inserts a new row below the selected row 

• Delete Row: Deletes the selected row 

 
Editing a table: The table can be moved when the mouse curser is above the lines of the table and is 

marked with the move icon . The vertical lines in a table can be moved when the mouse curser is above 
the end of a line and is marked with the move icon . 
 
Calculation expressions:  

+ Addition 
- Subtraction 
* Multiplication 
/ Division 
Sqrt(x) Square root of x 
Ln(x) Natural logarithm of x 
Log(x) Logarithm of x 
Exp(x) Natural exponential function of x 
Power(x,y) x to the power of y 
Round(x) Rounds x to the nearest integer 
Floor(x) Largest integer less than or equal to x 
Ceil(x) Smallest integer that is not less than x 

 

Plot Manager gate configuration 

 
 
The table in the ‘Gate Configuration’ window is used to configure settings for polygons, quadrants, and 
marker sets for the plot from which the gate configuration window was launched. 
 
The table lists all gates (polygons, quadrants, and markers) which have been defined in the associated row. 
NOTE: Gates marked as shown will only be shown in the plot, if the conditions for this are fulfilled, i.e. 
markers are only shown in histogram plots, and polygons are only shown in scatter plots. Furthermore, the 
axis parameters of the plot must be identical to the axis parameters for the gate.  
 
To disable the showing of a gate, deselect the checkmark in the show column. 
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Gate configuration: 

• Disable: Disables gating for the selected gate 

• Include: Displays all events inside the selected gate 

• Exclude: Displays all events outside the selected gate 

• Union: This option is available when two gates have been set to either Include or Exclude data. 
Selecting this option results in display of the sum of all events displayed for the two gates 
(included or excluded). 

• Intersection: This option is available when two gates have been set to either Include or Exclude 
data. Selecting this option results in display of the events displayed for both of the two gates 
(included or excluded). 
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Export Data 

 

In the menu line File → Export Data cell data can be exported to file formats which are compatible with 
third party software such as FCS Express. 

Format Specification: 
Select export format FCS for export according to ISAC ‘Data file standard for flow cytometry, Version 
FCS3.0’ format. 
Select export format ACS for export compatible with FCS Express 4 Image Cytometry. 
NOTE: To see images in FCS Express 4 Image, make sure that the Load images option under Edit Preferences 
→ Data loading → ICE format in FCS Express 4 Image is selected. 
 
Parameter Specification:  
The number of exportable parameters depends on the protocol used to create the *.cm image file. 
 
Multiple image files acquired with the same protocol can be batch exported by opening the File browser, 
selecting the desired files by holding Ctrl or Shift keys down and clicking the files, right-clicking and 
selecting ‘Batch export data’. 
 
Bitmap export 

Before exporting a bitmap for presentation or printing, increasing the contrast via the Image Scaling 
window often yields a better data visualization.  

Right-click on the image in the Main window and select Copy to clipboard (bmp image, all channels). Then 
paste into other applications or documents. 
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PDF report 

 
 

Functions available: 

• In the menu line File → Create PDF report, saves selected data to a PDF file. The PDF report 
function is also available by right-clicking on a file within the file list in the main window. 

• The report file name can be set and the location where to save the PDF file can be selected. Note 
that the extension of the file name must be ‘.pdf’. 

o The different sections to include in the PDF report can be selected. For some sections, the 
setup can be specified. In the image section, select the first image, all images, or a selection 
of images. Enhance and/or invert images, making the cells in the images clearer and 
inverting the background from black to white 

o For PDF reports intended for printing, we recommend selecting inverted images for better 
visualization and to save ink 

o In the Plot manager section, include the last saved data from the plot manager or the 
original raw data from when the cm file was created 

o Specify how many plots are shown per row before wrapping to next row. When specifying 
more than 2 plots per row the plot size is reduced accordingly  

o Specify the signatures for the person that has created the report and the person to approve 
the report and which of the signatures to include 

• The preview icon allows the user to see the preview of the PDF report. This preview will not be 
saved 

• Save the PDF report to the specified location and open automatically if chosen. Print the PDF to the 
default printer. Note that saving the PDF report is optional only if printing the report 

• Selections will be remembered for the next PDF report generation 
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A PDF report for multiple files can be created by opening the File Browser, selecting the files by left clicking 
while holding down Shift or Control and finally selecting Create PDF Reports after right clicking. This will 
open the PDF report dialog in a state where a prefix can be specified for the file names. The full PDF file 
name cannot be specified when multiple files are selected. The selected options for what to include in the 
PDF report will be applied for all selected files. 

Options 
 

    
General tab                  Authorization tab 

 

The Options dialog box contains the following tab pages and modification options: 

• General:  The software can be set to require a sample ID to be written for all selected chambers, 
before an analysis can be started. 

• When Always show Login ID in Operator field is checked, the Main Window Operator field shows 
Login ID and is read-only. In case the Login ID contains any hash characters (#), these will each be 
replaced by “_hash_”. In 21CFR11 mode it is only NucleoViewAdmin who may change this setting. 

• Image settings for the image display can be set to enhance and/or invert. The Enhance function will 
depict low pixel values brighter. Disabling the Enhance function will display the image linear scaled. 
The Invert function will depict the image inverted so the background appears white instead of black 
while the colors of each channel are preserved. 
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• Folders: The user can set the location of the result file folder and the new folder selection applies to all 
users. Please note that we do not recommend changing the result folder location to a network 
location, as this may cause slow reading of the relatively large image files depending on the network 
speed. It may also cause problems with saving new images during image acquisition if access to the 
network location is limited2. 

A copy of the results without the image can be saved as a csv file for every completed run of a 
protocol. The location for the folder, where to save the csv files, can be set by the user and the new 
folder selection can be applied for all users2 

• PDF Report:  A PDF report can be saved and/or printed for every completed run of a protocol. The 
location for the folder, where the PDF reports will be saved can be set and the folder selection can be 
applied for all users. The default folder for saving PDF report is in the NucleoView NC-250 folder on the 
desktop in the subfolder: \results\PDF reports2 

Saved PDF reports will be named with the same file name as the cm file name with a pdf extension and 
can be selected to open automatically. The PDF can be printed to the default printer if one is installed. 
This will result in a printed report for every completed run of a protocol. Note that it is optional to save 
the PDF report, if only printing the report is desired.  

For PDF reports intended for printing it is recommended to select inverted images for better 
visualization and to save black ink. In the Plot Manager section, it can be selected to include the last 
saved data from the plot manager or the original raw data from when the cm file was created. In 
addition, it can be specified how many plots may be shown per row before wrapping to next row. 
When specifying more than 2 plots per row the plot size is reduced accordingly. Finally, signatures for 
the person that has created the report and the person to approve the report can be specified and 
which of the signatures to include. 

The paper size can be specified to be A4 or letter size. 

• Authorization:  The 21 CFR Part 11 mode can be enabled or disabled if this license has been purchased. 
User rights to approve results can be set. User login options can also be enabled under this tab and do 
not require activation of 21 CFR Part 11 mode. See the 21 CFR Part 11-section for more details. 

 
Log in is mandatory at NucleoView™ start up if 'User login needed when starting' is enabled. Use 

 
2 If a user defined folder is set, but not available, the software will do one of the following things: A) When 21 CFR Part 
11 is disabled: Warn the user and temporary use the default folders. B) When 21 CFR Part 11 is enabled, either: B1) 
NucleoViewUser and NucleoViewSuporVisor group members cannot access the software, but instead present a 
warning asking them to contact a NucleoViewAdmin. Event log entries will be written in the default folder. B2) 
NucleoViewAdmin are given a warning when logging in, and software uses the default results folder. Event log entries 
will be written in the default folder. 
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Windows user credentials to log into NucleoView™ NC-250™. The User Name3 will be recorded in 
image- and event log files. If the 'User login needed when starting' option is disabled, the User Name 
used to log on to Windows will be recorded instead. 
In the figure above, user permissions are shown under default settings. Sample ID renaming is by 
default allowed, but can – individually for each of the NucleoView user groups be prevented, 
optionally with a 15 minutes grace period where the user can change Sample ID up to 15 minutes after 
the cm-file was created. Access to change which protocols are hidden is as default disabled, i.e. the 
‘Hide Protocols…’ button on the ‘Select Protocol’ window is not visible. To make the ‘Hide Protocols…’ 
button visible for any of the NucleoView user groups, set the corresponding box must be checked. 

  

 
3 ‘User Name’ is also referred to as ‘Login ID’ or ‘User’ in NucleoView 
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21 CFR Part 11 
The US regulatory agency Food and Drug Administration (FDA) have issued the 21 Code of Federal 
Regulation 21 Part 11; Electronic Records, Electronic Signatures (21 CFR Part 11). In short, 21 CFR Part 11 
defines the FDA acceptance criteria for use of electronic records and electronic signatures as equal to paper 
records with handwritten signatures. 
 
The NucleoView NC-250™ software can be set to a restricted mode, so the user via the NucleoView™ NC-
250™ software itself can not violate 21 CFR Part 11 regulations. This means that on a computer system that 
is 21 CFR Part 11 compatible, it is possible to keep the compliancy even after installation and use of the 
NucleoView™ NC-250™ application.   
Using a 21 CFR Part 11 compliant version of the NucleoView™ NC-250™ software requires a specific license 
that should be purchased in addition to the NucleoCounter NC-250™ instrument and NucleoView™ NC-
250™ software. 
 
Please refer to the document Guide for 21 CFR Part 11 on NucleoView™ NC-250™ (document no. 991-0256) 
for details on operating NucleoView™ NC-250™ in 21 CFR Part 11 mode and how the 21 CFR Part 11 scripts 
are activated. 
 
Also refer to the document NucleoCounter® NC-250™, NucleoView™ NC-250™ Software and Code of Federal 
Regulation 21 Part 11; Electronic Records, Electronic Signatures (document no. 994-0271) for a description 
of what approach ChemoMetec has taken to meet each relevant section in the 21 CFR Part 11 guidelines. 
 

Event Log 
 
The Event Log function creates an audit trail of all user activity within the NucleoView™ NC-200™ software.  
 
Please refer to the document Guide for 21 CFR Part 11 on NucleoView™ NC-250™ (document no. 991-0256) 
for a description of the Event Log function and viewer. 
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License, protocol, and documentation installation 
 

Introduction 

To run a given protocol, the corresponding protocol, license, and documentation files must already be 
installed. This is usually performed during the NucleoView™ NC-250™ software installation, but it can also 
be done later as described in the next section. 
 
Install licenses, protocols and protocol documentation as follows: 

1. In the menu select File->Import Package 
2. In the file selection browser pop up window, browse to and select the file you want to install. 

This will typically be a zip-file containing multiple license, protocol and documentation files, or it 
may be e.g. individual *.cmsx, *.cmsup and *.pdf  

If you want to install extra licenses and protocols at a later time, this is done using the same procedure. The 
new elements will simply be added to the existing collection. 
 
Important: Do not edit license files or protocol files manually as this will invalidate the files. 
 
Select View → License file to see a list of installed licenses. 
 
A license is typically valid for a particular NucleoCounter® NC-250™ instrument (identified by serial 
number). A license may have an expiry date.  
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Maintenance and backup 
 

NucleoView™ NC-250™ software maintenance 

A two-channel image taken in an A8 slide with NucleoView™ NC-250™ is approximately 15 MB in size. 
Therefore, performing e.g. 50 Viability and cell Count assay captures each day for a month will accumulate 
approximately 16 GB data. 
Hence, we recommend to backup results and free up disc space regularly to ensure trouble-free operations. 
Each time a protocol run is started, NucleoView™ NC-250™ tests for sufficient disk space and if not 
available, aborts the protocol with an error message to the user. 
See Analysis results for details on file types and locations. 
 
NucleoView™ NC-250™ constantly records all operations in event log files. These event log files should be 
handled in the same manner as the image files with respect to backing up and freeing up disc space. The 
event log files are always stored in the current results folder. One file is created for each month, and files 
are named according to the rule <year><month>.logx, e.g. 201610.logx, indicating a log file from October 
2016. 
 
NucleoView™ NC-250™ software including standard protocols is typically delivered on a USB stick, and 
protocols and licenses are distributed as zip-files via e-mail, USB sticks or other media platforms. 
The user must keep appropriate backups of these zip-files in order to be able to make a new installation in 
case re-installation of the software is required. 
 

NucleoCounter® instrument maintenance 

ChemoMetec provides specific Installation Qualification (IQ), Operation Qualification (OQ) and 
Performance Qualification (PQ) protocols and associated test kits, which are used to verify proper 
operation of the NucleoView™ NC-250™ and NucleoCounter® NC-250™ systems. 
 
Please refer to the NucleoCounter® NC-250™ instrument user guide for recommendations regarding 
instrument cleaning and maintenance.  
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How to 
 

How to get context-sensitive help 

While focusing on a control in a specific window, press F1 (not applicable on the Main window). This will 
launch the software manual on the relevant page.  
 

How to verify correct operation of the NucleoCounter® NC-250™ instrument after transportation 

The NucleoCounter® NC-250™ instrument is a very robust device which handles shipping well, provided it is 
packaged correctly in the original shipping box. In case of extreme physical stress, it may suffer internal 
damage and/or misalignment. 
 
After transportation, we recommend running the Installation Qualification (IQ) protocol. This protocol will 
inspect critical internal alignment and report any changes or errors. 
 
The Operation Qualification (OQ) protocol verifies correct operation of the instrument.  
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Keyboard shortcuts 
Image  

+ Zoom in 

- Zoom out 

Arrow keys Pan up, down, left, or right in displayed image 
  
 
Application selection 

 

F1 Quick selection of protocol attached to favorite F1 key 

F2 Quick selection of protocol attached to favorite F2 key 

F3 Quick selection of protocol attached to favorite F3 key 
 
Note: Shortcut usability depends on actual focus.  
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Troubleshooting 

Installation  
The NucleoView™ NC-250™ 
software or the 
NucleoCounter® NC-250™ 
instrument are not installed 
correctly. 

 
The user must be logged on with administrator rights during 
installation. 
 
When connecting the NucleoCounter® NC-250™ instrument to a 
previously unused USB port, the NucleoView NC-250™ software may 
need to reinstall the camera drivers and will prompt the user to do 
so. This operation may need administrator rights, so either use 
another USB port where the camera has already been installed or log 
on with administrator rights and complete the camera installation as 
described in Installation of Instrument. 
During connection to the instrument, you may see an error message 
from Windows, which is not of any consequence. Click Close on any 
of these pop-up messages if needed.  

NucleoView™ NC-250™ issues  
Protocol file is invalid 
 
 
 
Connection error 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The license file is corrupted, missing or does not include a license for 
the selected protocol. The appropriate license must be installed as 
described in the License, protocol, and documentation installation 
section. 
 
The NucleoCounter® NC-250™ instrument icon in the upper left 
corner of the main window stays red after NucleoView™ NC-250™ 
has been launched, i.e. the NucleoView™ NC-250™ software does 
not connect to the instrument. This may be caused by an error in the 
USB connection.  
To inspect and solve connection errors: 

• Check that power is connected 

• Check that the USB cable delivered by ChemoMetec is 
connected to the instrument and a USB port on the 
computer. Never connect the instrument to the PC through 
an external USB hub or extender cable 

• For desktop users, please connect the instrument to an USB 
connector that is directly connected to the motherboard. 
These connectors are typically located at the back of the PC 

• Open the Control panel and launch ‘System’. Select the 
Hardware tab and click Device manager. In case of a USB 
driver error there will be a USB item marked with a yellow 
dot containing an exclamation mark. Select properties for 
this item and select the driver tab. Select Update driver and 
let the system automatically select a driver 
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Taking snapshot failed 
 
 
 
 
 
 
 
 

 
 
Free system memory is low 
 
 
 
 
Free process memory is low 
 
 
 
 
 
 
Sharing violation on cm files 
 
 
 
 
 
 
The NucleoView™ NC-250™ 
interface looks strange 

This warning is shown when the acquisition of an image by the 
camera fails. This is most likely due to problems with the USB 
transfer of data from the camera to the computer. This can occur 
because of many things: 

• Another cable than the delivered USB cable is used 

• The USB cable is connected to the computer via a HUB or 
extension cable 

•  A USB 2.0 port is not used 

• The computer is not updated to the latest USB driver set 
• The computer bios is outdated 

 
This warning text may be shown in red in the mouse info field on the 
Plot Manager when the system memory is very low. Free up system 
memory by closing unused applications and/or removing surplus 
rows in the Plot Manager. 
 
This warning text may be shown in red in the mouse info field on the 
Plot Manager when the process memory available for the software is 
very low. A beeping alarm sound will also be given, as there is 
eminent risk of getting a software crash if you continue working with 
the Plot manager. Free up process memory by removing unneeded 
rows in the Plot Manager or by closing the Plot Manager. 
 
This warning may be shown when a program such as a virus 
protection program is scanning the cm file while NucleoView™ NC-
250™ is trying to access the same file. In virus protection programs 
disable scanning of the ChemoMetec folder: 
C:\Users\Public\Documents\ChemoMetec.  
Furthermore, if alternative folders are selected in the options in 
NucleoView™ NC-250™, also disable scanning of these folders. 
 
NucleoView™ NC-250™ only works with 100% scaling. 
In the Control panel, click Appearance and personalization. Under 
the Display heading, click Make text and other items larger or 
smaller.  
Select 100 % scale, and then click Apply. 

Media type 
Persistent turbulence 
detected  

 
Persistent turbulence may occur when air is trapped inside the 
media type, coursing liquid movement and thereby also movement 
of cells. Furthermore, if the instrument is placed on the same table 



 
 NucleoView™ NC-250™ user guide 

Document type: User Guide Document version: 1.13   
Document no.: 991-0252 Approved by: iap Approved date: 07nov2022 System ID: 11470 

 

ChemoMetec A/S · Gydevang 43 · DK-3450 Allerod · Denmark · support@chemometec.com · www.chemometec.com  Page 65 of 66 
 

as other equipment that cause vibrations, this can also cause 
detection of turbulence. 

NucleoCounter® NC-250™  
The sample tray is ejected, 
and the instrument is on 
standby 
 
 
The instrument gives 
abnormal sounds 

  

 
The connection between the NucleoCounter® NC-250™ and 
NucleoView™ NC-250™ software has been terminated in an 
inappropriate way while the tray was ejected. 
Restart NucleoView™ NC-250™ and the tray is automatically 
retracted. 
 
An actuator motor might be blocked. 
Inspect that the sample tray movement has not been blocked by any 
external objects, then check that there is no internal blocking, e.g. by 
a wrongly located cassette. 
Remove any blocking devices and restart the NucleoView™ NC-250™ 
software. 
If issues persist contact ChemoMetec support or local 
representative. 
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Appendix A: Changes to user guide from last revision 
 
 
1. Minor editorials 

 


	Quick guide
	Installation guide
	Installation overview
	Minimum computer requirements and preparations before installation
	Installing NucleoView™ NC-250™ software on the NucleoCounter® NC-250™ instrument
	Installing licenses and protocols
	Software upgrade
	Installing a new NucleoCounter® instrument
	Uninstall NucleoView™ NC-250™ software
	Validation with IQ, OQ and PQ protocols
	Installation Qualification (IQ test)
	Operation Qualification (OQ test)
	Performance Qualification (PQ test)

	Main window
	Menu line functions

	Selecting a protocol
	Analysis results
	Browse results
	File browser
	File properties
	Report generator
	Image scaling
	Image overlay
	Next analysis
	Protocols
	Protocol Adaptation Wizard
	Plot Manager
	Layout editing
	Plot statistics
	Row window in Plot Manager
	Histogram plot in Plot Manager
	Large histogram plot in Plot Manager
	Scatter Plot in Plot Manager
	Large scatter plot in Plot Manager
	Table plot in Plot Manager
	Large table plot in Plot Manager
	Plot Manager gate configuration

	Export Data
	PDF report
	Options
	21 CFR Part 11
	Event Log

	License, protocol, and documentation installation
	Introduction

	Maintenance and backup
	NucleoView™ NC-250™ software maintenance
	NucleoCounter® instrument maintenance

	How to
	How to get context-sensitive help
	How to verify correct operation of the NucleoCounter® NC-250™ instrument after transportation

	Keyboard shortcuts
	Troubleshooting
	Appendix A: Changes to user guide from last revision

